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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of Seiko Epson Corporation. The information contained herein is designed only for use with 
this Epson printer. Epson is not responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for 
damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of 
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to 
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or 
any consumable products other than those designated as Original Epson Products or Epson Approved Products by 
Seiko Epson Corporation.

Responsible Use of Copyrighted Materials
Digital cameras or scanners, and ink jet printers, like photocopiers and conventional cameras, can be misused by 
improper copying or printing of copyrighted material. While some countries’ laws permit limited copying of 
copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. 
Epson encourages each user to be responsible and respectful of the copyright laws when using digital cameras, 
scanners, and ink jet printers. 

Trademarks
Epson, Epson Stylus, Epson Photo Stickers, MicroWeave, PRINT Image Matching, and the PRINT Image 
Matching logo are registered trademarks, and Exceed Your Vision is a trademark of Seiko Epson Corporation. 

USB DIRECT-PRINT™ and the USB DIRECT-PRINT logo are trademarks of Seiko Epson Corporation. 
Copyright © 2002 Seiko Epson Corporation. All rights reserved.

BorderFree, RPM, Resolution Performance Management, and ColorLife are registered trademarks; PhotoEnhance 
is a trademark; and Epson Print Lab, Epson Store, SoundAdvice, and Epson Connection are service marks of 
Epson America, Inc.

PremierArt is a trademark. 

DPOF™ is a trademark of CANON INC., Eastman Kodak Company, Fuji 
Photo Film Co., Ltd. and Matsushita Electric Industrial Co., Ltd.

SD™ is a trademark.

Memory Stick, Memory Stick Duo, Memory Stick PRO, and Memory 
Stick PRO Duo are trademarks of Sony Corporation.

xD-Picture Card™ is a trademark of Fuji Photo Film Co.,Ltd.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. Epson disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

CPD-20396
© 2005 Epson America, Inc. 7/05
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Welcome!

Your Epson Stylus® Photo R340 can print pictures directly from your digital camera’s memory 
card. You can create true BorderFree® photos directly from your printer in a variety of sizes 
just minutes after taking pictures with your digital camera. These photos are perfect for 
placing in albums, framing, or sharing with family and friends.

If you want to save your image files, you can transfer them immediately to your Windows® or 
Macintosh® computer and print them later from your PC. 

Here are some of the printer’s outstanding features:

■ Epson’s exclusive 6-color ink technology lets you achieve fine shadow detail, dazzling 
highlights, and excellent fill across a wide range of colors. Genuine Epson® ink and papers 
create long-lasting and water-resistant prints.

■ CD and DVD printing on ink jet-printable CDs and DVDs, with or without a 
computer. 

■ Resolution Performance Management® (RPM®) technology optimizes the number and 
placement of ink droplets on a variety of papers for superior photo quality and 
performance, with manageable print file sizes.

■ Three built-in memory card slots support CompactFlash® Type I and II, Secure Digital, 
MultiMediaCard,™ xD Picture Card,™ SmartMedia,™ Sony® Memory Stick,® Memory 
Stick PRO,™ (Memory Stick Duo,™ Memory Stick PRO Duo [adapter sold seperately]), 
and IBM® Microdrive.™ 

■ An extra USB port on the front of the printer lets you connect a digital camera 
(supported models only) or an external storage device, such as an Iomega® Zip® drive or 
CD-R drive. This lets you save your memory card contents to a Zip disk or CD-R and 
access stored photos without a computer. (The port on the back of the printer is for 
connecting the printer to your computer.)

■ A color LCD preview panel helps you select photos for printing.

■ Your printer also supports Bluetooth® technology (using an optional adapter) for sending 
prints wirelessly from Bluetooth-enabled phones, PDAs, etc. 
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8 Welcome!

About Your Documentation

To set up your printer and install its software, see the Start Here sheet. For basic printing 
without a computer, see the Quick Reference card. This book contains system requirements, 
important safety information, your warranty, and instructions on:

■ Viewing your on-screen User’s Guide 

■ Printing all types of photos without a computer

■ Printing with Windows or on a Macintosh 

■ Maintaining the printer

■ Solving basic problems

For more details about printing with, maintaining, or troubleshooting your printer, see your 
on-screen User’s Guide, as described below. 

Warnings, Cautions, Notes, and Tips

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.

Viewing Your On-Screen User’s Guide

Your printer CD-ROM includes an on-screen User’s Guide. 
You need a browser—such as Microsoft® Internet Explorer 
4.0 or later, Netscape Navigator® 3.0 or later, Mozilla 
FireFox 1.0 or later, or Safari™ 1.0 or later—to view it. If 
you are using a different browser, the pages may not display 
correctly. (A browser is not included on the printer software 
CD-ROM.)

To view the on-screen User’s Guide, double-click the 
SPR340 User’s Guide icon on your desktop. 

Click the blue links to view the listed topics. Click the 
Home button to return to the main screen. 
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Loading Paper

Epson offers a wide variety of papers that let you customize your projects and achieve 
professional results. This chapter gives you guidelines on:

■ “Loading Paper in the Sheet Feeder” below

■ “Storing Your Photos” on page 10

Loading Paper in the Sheet Feeder 

1. Open the paper support and raise the extension.

2. Place your paper short edge first against the right edge of the feeder, under the tab, with 
the printable (whiter or glossier) side up. If you are loading multiple sheets, fan the stack 
of paper before loading it to prevent paper jams.

Note: Don’t load paper above the arrow mark inside the left edge guide. Some special 
papers can be loaded only one sheet at a time. See your on-screen User’s Guide for 
details. 

3. Slide the left edge guide against the paper. Make sure it is snug, but not so tight that the 
paper is bent. (For letter-size paper, you may not need to move the edge guide over.) 

Letter 4 × 6
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10 Loading Paper

4. Open the output tray and pull out the extension.

You should also follow these guidelines: 

■ Always load the short edge first, even when you’re printing landscape-oriented pictures.

■ When using special papers, check the paper package for additional instructions. Some 
papers require using a support sheet included in the package.

Note: Always keep unused paper in the original package and store it flat to prevent curling.

For instructions on loading special papers and envelopes in the printer, see your on-screen 
User’s Guide.

Storing Your Photos

With proper care, photographs from your Epson Stylus Photo R340 will last for many years. 
The special Epson inks designed for your printer are formulated to achieve improved 
lightfastness when used with Epson papers for prints that are properly displayed or stored. 

As with traditional photos, proper care will minimize color changes and lengthen display life:

■ For display, Epson recommends that prints be framed under glass or a protective plastic 
sleeve to protect them from atmospheric contaminants like humidity, cigarette smoke, 
and high levels of ozone. 

■ As with all photographs, keep your prints away from high temperatures and humidity and 
out of direct sunlight. 

■ For proper storage, Epson recommends that you keep prints in a photo album or plastic 
photo storage box in acid-free, archival sleeves commonly available from most camera 
stores.

Be sure to follow any other storage and display instructions included in the paper package.
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Accessing Photos

Follow the instructions in these sections to access your photos:

■ “Inserting Memory Cards” below

■ “Connecting External Devices” on page 12

■ “Viewing a Slide Show of Your Photos” on page 15

■ “Copying Photos to Your Computer” on page 15

Inserting Memory Cards

1. Press the P power button to turn on your Epson Stylus Photo R340.

2. Open the memory card door.

3. Insert the memory card into one of the three slots, as shown below.

Note: Insert just one card at a time. See your on-screen User’s Guide for supported photo 
file formats.

4. Push the card in carefully until it stops (it doesn’t go in all the way). When it is in, the 
card light comes on. 

5. Close the memory card door.

CompactFlash or 
Microdrive 

(left)

Memory Stick, 
SD (Secure Digital), or 

MMC (MultiMediaCard)
(middle)

SmartMedia or
xD Picture Card 

(right)
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12 Accessing Photos

After a moment, the printer reads and counts the number of images on your card. When 
it’s done, your images are available for printing (see page 17). 

Removing Memory Cards

If your printer is connected to your computer, see page 16 for instructions on removing your 
memory card. 

Otherwise, make sure the card light is not flashing, then pull the card straight out of the slot.

Caution: Do not eject a card while the card light is flashing or without performing the steps 
described below, or you may lose data on the card. Be sure all cards have been removed 
before unplugging the USB cable.

Connecting External Devices 

If you have one of the following devices, you can connect it directly to your printer using a 
USB cable: 

■ Digital camera with PictBridge® or USB DP (USB Direct Print™) support

■ USB thumb drives (see http://support.epson.com for a list of compatible drives)

■ USB CD/DVD burners and drives (see http://support.epson.com for a list of compatible 
drives)

■ 100 or 250MB Iomega Zip drive, AC or USB powered

■ Memory cards with a commercially available USB adapter (such as the MicroTech™ 
ZiO!™)

Note: Epson cannot guarantee the compatibility of any cameras or drives. If you’re not sure 
about your camera or drive, you can try connecting it. If it’s not compatible, you’ll see a screen 
saying that the connected device cannot be used.

If you are using a Zip disk or a thumb drive, it must be formatted as a FAT16 disk. If you 
insert a Macintosh-formatted Zip disk or thumb drive, you see an error message saying that 
the inserted card cannot be used with the printer.

Card light
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Connecting External Devices 13

Tip: When you connect a CD drive, you can also print photos from Picture CDs that you get 
from your photo lab.

When you connect a digital camera or storage device, the printer treats it like a memory card. 
Follow these steps to connect it:

1. Remove any memory cards from the printer.

If you leave a card in the printer, images will be read from the card instead of your camera 
or storage device.

2. Connect the USB cable from your camera or storage device to the EXT I/F USB port on 
the front of the printer. Some digital cameras require a special USB cable; if so, be sure to 
use the one that came with the camera.

3. Turn on the printer and your camera or storage device. 

After a moment, the printer reads and counts the number of images. When it’s done, your 
images are available for printing (see page 17). 

Note: If you used the Stylus Photo R340 to back up your images on a Zip disk, CD, or another 
storage device (see page 14), they’re stored in folders (001, 002, etc.). Use the u and d 
buttons on the printer’s control panel to highlight the folder you want to open, then press OK 
to open it. 
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Saving Your Photos to an External Device

If you don’t have a computer, you can save photos that are on your camera’s memory card to 
an external device that you connect directly to your printer. This lets you delete the images on 
your memory card and reuse it without losing your original photos. Follow the steps below to 
save your photos to a Zip disk, CD-R, DVD-R, or thumb drive.

Note: Epson cannot guarantee the compatibility of any cameras or drives. If you’re not sure 
about your camera or drive, you can try connecting it. If it’s not compatible, you’ll see a screen 
saying that the connected device cannot be used.

1. Make sure the printer is turned on and the memory card you want to back up is inserted 
in the printer.

2. If the printer is connected to your computer, unplug the USB cable that connects the 
printer to your computer (otherwise files on the memory card may be copied to your 
computer).

3. If necessary, make sure your drive is plugged in and turned on. Then connect a USB cable 
from your drive to the EXT. I/F USB port on the front of the printer (see page 12).

4. Press the Setup button on the printer.

5. Press the d button to choose Backup and press OK. 

6. Press OK. When you see the “Start backup” message, press OK again to start the backup 
procedure. You may have to follow additional instructions on the printer screen. All the 
photos on your card are copied to your external storage device. Depending on how many 
photos there are, this may take several minutes. 

Caution: Once the backup starts, don’t press any buttons on the printer or interrupt the 
process, or you may lose photos on your card or drive. If you need to stop the backup, 
press the y Stop button.

To print images saved on your external storage device, follow the instructions on page 17.
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Viewing a Slide Show of Your Photos 15

Viewing a Slide Show of Your Photos

1. Insert a memory card (see page 11) or connect a USB device (see page 12). 

2. Press the Memory Card button to set the printer to Memory Card mode.

3. Press l to choose Play Slide Show. 

4. Press OK. The printer plays the slide show. 

Note: The printer automatically rotates any portrait photos so they appear upright. 

5. To pause the slide show while it is playing, press OK. To stop the slide show, press Back. 

Copying Photos to Your Computer 

If you’ve taken digital photos with your camera, you can insert the memory card into your 
printer’s memory card slot and copy the photos to your computer. You can access the contents 
of the card just like any drive on your computer. 

1. Make sure your computer and printer are connected and turned on.

2. Open the memory card door.

3. Insert the memory card into the appropriate slot on the printer, as shown on page 11.
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4. In Windows XP, you see a screen like the one on the 
right. Choose one of the supported programs or options 
to open, view, or print your photos. If you don’t see this 
screen, click Start > My Computer. Then double-click 
the removable disk icon to access your photos. 

In Windows 98, Me, or 2000, double-click the My 
Computer icon. Then double-click the removable disk 
icon to open, view, or print your photos. 

In Mac OS® X, a drive icon appears on your desktop. You 
can open the drive and copy your photos to your 
computer. If you have iPhoto® and you have it set to open when a digital camera is 
connected, it will open when you insert a memory card. 

Caution: If you access the card from your computer and delete files from the card, add files to 
the card, or format the card, the card may not work correctly with your camera and the printer 
may not be able to read the files on the card. Always format cards and delete pictures using 
your camera, and do not copy files to the card from your computer.

Removing a Memory Card

Once you’re finished copying photos from your memory card, follow the steps below to 
remove it. Be sure to remove any cards before unplugging the USB cable from your printer. 

Caution: Do not eject a card while the card light is flashing or without performing the steps 
described below, or you may lose data on the card. Be sure all cards have been removed 
before unplugging the USB cable.

1. Depending on your operating system, you may need to do one of the following:

■ In Windows Me or 2000, click the  Unplug or Eject Hardware icon on the 
taskbar. Click Stop USB Mass Storage Device.

■ In Windows XP, click the  Safely Remove Hardware icon on the taskbar. Then 
click Safely Remove USB Mass Storage Device. 

■ On a Macintosh, drag the memory card icon from your desktop to the trash.

2. Then remove your card by pulling it straight out of the slot.
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Printing Without a Computer

Your Epson Stylus Photo R340 lets you print photos quickly and easily without a computer. 
Just load paper, insert your digital camera’s memory card, choose print settings from the 
control panel, and press the x Start button.

Follow the instructions in these sections to print:

■ “Printing Photos” below

■ “Choosing Print Settings” on page 20

■ “Touching Up Your Photos” on page 21

■ “Cropping and Sizing Your Photos” on page 23

■ “Printing on CDs and DVDs” on page 24

■ “Resetting Default Settings” on page 28

Printing Photos

Before you begin, make sure the printer is in Memory Card mode. If the 
printer is in CD/DVD mode, press the Memory Card button. 

Before you print, make sure you load paper (see page 9) and insert your 
camera’s memory card in the appropriate card slot (see page 11), or connect an 
external device that has photos (see page 12). 
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18 Printing Without a Computer

Viewing and Printing Photos

The View and Print option lets you preview and choose individual photos to print. 

1. Press l or r to choose View and Print Photos, then 
press OK.

2. Press l or r to choose the photo you want to print.

3. Press u or d to select the number of copies. 

4. Repeat steps 2 and 3 for each additional photo you want 
to print.

5. Press the Print Settings button and choose your print settings (see page 20). 

6. Press the x Start button to print your photo(s).

Note: To cancel printing, press the y Stop button.

Printing All the Photos on a Memory Card

The Print All Photos option lets you print all the photos on your memory card at once. 

1. Press l or r to choose Print All Photos, then press OK.  

2. Press u or d to select the number of copies. 

3. Press the Print Settings button and choose your print 
settings (see page 20). 

4. Press the x Start button to print your photos.

Note: To cancel printing, press the y Stop button.

Printing a Range of Photos

Choose and print a sequence of photos on your card—for example, photos 7 through 12. 

1. Press l or r to choose Print Range of Photos, then 
press OK.

2. Press l or r to choose the first photo you want to print.

3. Press l or r to choose the last photo you want to print.

4. Press u or d to select the number of copies. 

5. Press the Print Settings button and choose your print 
settings (see page 20). 
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Printing Photos 19

6. Press the x Start button to print your photos. 

Note: To cancel printing, press the y Stop button.

Printing Photos from a Specific Date

Print all the photos taken on a specific date that are stored on your memory card. 

1. Press l or r to choose Print by Date, then press OK.

2. Press u or d to choose a date, then press r to select it. 
(Select a date and press l to deselect it.)

3. Repeat step 2 for each date you want to choose for printing. 

4. Press u or d to select the number of copies. 

5. Press the Print Settings button and choose your print 
settings (see page 20). 

6. Press the x Start button to print your photo.

Note: To cancel printing, press the y Stop button.

Printing a Proof Sheet

Print a proof sheet showing thumbnail images and photo numbers for all the photos on 
your card. 

1. Press l or r to choose Print Proof Sheet, then press OK.

2. Press the Print Settings button and choose your print 
settings (see page 20). 

Depending on your paper size, the proof sheet will print in 
20-, 30-, or 80-up layouts, as shown: 

3. Make sure you have enough sheets of paper loaded to print all the images on your card, 
then press the x Start button to print your proof sheet(s).

Note: To cancel printing, press the y Stop button.

Letter, 80-up5 × 7, 30-up4 × 6, 20-up
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20 Printing Without a Computer

Choosing Print Settings

After choosing the photos you want to print (see page 17), make sure you choose the 
appropriate settings for your paper type, size, and print layout, as described below. 

1. Press the Print Setting button. 

2. Press the d button to choose Paper Type, then press OK.

3. Select the setting that matches the type of paper you loaded, then press OK. Refer to the 
table below:

4. Press d to select Paper Size and press OK. 

5. Press u and d to choose your paper size and press OK. 

6. After selecting the paper size, press d to select Layout and press OK.

For this paper Select this Paper Type setting

Epson Ultra Premium Glossy Photo Paper Ultra Premium

Epson Premium Glossy Photo Paper Premium Glossy

Epson Premium Semigloss Photo Paper
Epson Semigloss Scrapbook Photo Paper

Semigloss

Epson Premium Luster Photo Paper Premium Luster

Epson Photo Paper
Epson Glossy Photo Paper
Epson Glossy Photo Greeting Cards

Photo Paper

Epson Matte Paper Heavyweight
PremierArtTM Matte Scrapbook Photo Paper

Matte

Plain paper
Epson Photo Quality Ink Jet Paper
Epson Premium Bright White Paper

Plain Paper
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7. Select one of the following layout options, then press OK.

Note: If you don’t see the entire image in your prints, check to make sure Fit to Frame is not 
enabled (see page 24). 

Touching Up Your Photos

Your Epson Stylus Photo R340 lets you correct the color and improve the image quality of 
your photos without using a computer. 

Note: These settings affect only your printed pictures. They do not change your original image 
files.

Automatically Adjusting Your Photos

When you use the printer’s automatic image adjustments, the adjustments are applied to all 
your photos. By default, the automatic adjustments are enabled. 

1. Press the Print Settings button. 

2. Press the d button to choose Auto Correct, then press OK.

Prints one photo per sheet, borderless; fits the photo lengthwise on the paper.

Prints one photo per sheet with borders around the edges.

Prints a photo on the top half of the sheet.

Prints two photos per sheet.

Prints four photos per sheet.

Prints eight photos per sheet.

Prints 20 photos per sheet; the photo number and date are also printed with each 
photo. (Good for printing larger-size index prints.)

Prints a CD/DVD jewel case insert with one photo on one side of the insert.

Prints a CD/DVD jewel case insert with twenty-four photos; twelve on each side 
of the insert.
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3. Select from these options, then press OK:

■ P.I.M.: Uses your camera’s PRINT Image Matching or Exif Print settings (this option 
is automatically selected when your pictures contain P.I.M. data). 

■ Exif: Uses your camera’s Exif Print settings (this option is automatically selected when 
your pictures contain Exif Print data). 

■ PhotoEnhance: Adjusts the brightness, contrast, and saturation of your photos. For 
example, if you have a photo with a subject that is too dark because of a bright 
background (backlighting), PhotoEnhance™ might be able to improve the brightness 
levels so that the person’s face is brighter in the printout. (The PhotoEnhance face 
lighting adjustment works best with faces that take up a significant portion of the 
photo, and where both eyes are visible.) 

■ None: Select this if you don’t want to use P.I.M., Exif, or PhotoEnhance. 

Note: These settings remain in effect until you change them. To reset all settings to the 
defaults, see page 28. 

To make manual adjustments in addition to the automatic ones, follow the steps in the next 
section. 

Manually Adjusting Your Photos

1. Press the Print Setting button. 

2. Press d or u to choose one of these options, then press the r button: 

■ Quality: Choose Standard, Higher, or Highest

■ Filter: Choose Off, Black & White, or Sepia 

■ Brightness: Choose Standard, Brighter, Brightest, Darker, or Darkest

■ Contrast: Choose Standard, Higher, or Highest

■ Sharpness: Choose Standard, Sharper, Sharpest, Softer, or Softest

■ Saturation: Choose Standard, Higher, Highest, Lower, or Lowest

■ Density: Available for CD/DVD printing; choose Standard, Darker, or Darkest 

3. Adjust any settings as necessary, then press OK. 

Note: These settings remain in effect until you change them. To reset all settings to the 
defaults, see page 28. 

Pbasics.book  Page 22  Monday, August 1, 2005  12:31 PM



Cropping and Sizing Your Photos 23

Cropping and Sizing Your Photos 

Your Epson Stylus Photo R340 lets you decide how your photos fit on the page with 
cropping, expansion for borderless prints, and fit to frame. 

Cropping with the Zoom Buttons

You can use the zoom buttons to crop out only the part of the photo you want to print. This 
does not affect your original image file, only the printout. 

1. Press l or r to choose View and Print Photos, then press OK.

2. Press l or r to select the photo you want to print.

3. Press the  button twice. You see an orange frame around the cropped area.

4. You can adjust the frame as follows: 

■ Press the  and  buttons to change the frame size.

■ Press the r, l, u, and d buttons to move the frame position.

■ Press the Print Settings button to rotate the frame.

5. When you are done, press OK. 

Note: This setting remains in effect until you print or press the y Stop/Clear button.

Borderless Expansion

If you are printing borderless photos, you can change the expansion setting to eliminate white 
borders on the edges (allowing part of the image to be cropped) or to allow a small white 
border and to print the entire photo without cropping. 

1. Press the Print Settings button. 

2. Press the d button to choose Borderless Expansion, then press OK.

3. Choose Standard (the largest image expansion), Middle, or Minimum, and press OK. 
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Fit to Frame

If your photo is too long or wide to fit inside the available space on your selected layout, part 
of the image will be automatically cropped. This setting applies to all photos, not just 
borderless layouts. 

To turn automatic cropping off or on:

1. Press the Print Settings button. 

2. Highlight Fit to Frame and press r. 

3. Select Off or On and press OK. 

Note: These settings remain in effect until you change them. To reset all settings to the 
defaults, see page 28. 

Printing on CDs and DVDs

You can print on ink jet-printable CDs and DVDs without even turning on your computer. 

You can order ink jet-printable CDs and DVDs from your local retailer or several websites, 
including www.epsonstore.com, www.pcmall.com, www.cdw.com, www.zones.com, 
www.warehouse.com, www.macconnection.com, and www.pcconnection.com. 

Caution: Use only ink jet-printable CDs or DVDs for printing. Thermal-printable and regular CDs 
and DVDs should not be used with this printer.

Follow the steps in the sections below to print on CDs and DVDs. 

■ “Cleaning the Roller” on page 25 

■ “Inserting a CD or DVD” on page 25 

■ “Printing Your CD or DVD” on page 26

■ “Adjusting the Printing Position” on page 27

Fit to Frame turned on Fit to Frame turned off

Cropped area
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Cleaning the Roller

Before you print on CDs or DVDs, it’s a good idea to clean the roller inside the printer. You 
can do this by feeding and ejecting several sheets of plain paper. 

1. Make sure the printer is turned on and letter-size plain paper is loaded in the sheet feeder.

2. Press the Setup button.

3. Press d to select Paper Feed/Paper Eject and press OK. 

4. Press OK to feed paper into the printer. 

5. Make sure Paper Feed/Paper Eject is still highlighted, then press OK. 

6. Press OK again to eject the paper from the printer. 

7. Repeat steps 3 through 6 three or four times.

Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink jet-printable CDs or DVDs before 
you print. Otherwise, dirt or scratches on the surface may cause errors when you burn the 
data. If you plan to print large numbers of CDs or DVDs, it’s a good idea to print a small 
sample, then wait a day and check the quality to make sure it is satisfactory. 

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the disc may 
not be positioned correctly. 

Follow these steps to load CDs and DVDs into your printer:

Caution: If you don’t insert the tray correctly, you may damage the printer or tray.

Note: To print on small CDs (8 cm), you must print from EPSON Print CD on the computer. See 
page 38. 

1. Push in the output tray extension and lower the CD/DVD tray guide. 

Lower CD/DVD 
tray guide

Push in 
extension 
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2. Place the CD or DVD on the CD tray with the white or printable side face-up. Make sure 
the disc lies flat on the tray.

3. Insert the tray into the printer carefully, making sure it is level, not tilted up or down. 

Slide the tray under the tab and the two rollers. Push it in until the arrows on the tray and 
guide are aligned. Don’t push the tray in too far; line up the arrows exactly. 

4. Follow the instructions below to print your CD or DVD. 

Printing Your CD or DVD

After you have loaded a CD or DVD, you’re ready to print.

1. Press the Print CD/DVD button to select CD/DVD print mode if it is not 
already selected. 

Line up arrows

Keep tray level

Load tray under tab
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2. If you want to change the layout settings, press Print Setting. Press d or u to select the 
following options:

Note: All photos are printed in landscape mode. 

3. Press l or r to choose a photo. Press u to choose 1 for the Copies setting. This will print 
1 copy of the selected photo on your CD. (If you want to print multiple photos, change 
the Layout setting first, as described below, then repeat this step for each photo you want 
to add to your CD/DVD layout.)

4. Press the Print Settings button and choose additional print settings (see page 21). 

5. Press the x Start button to print your photos.

Note: To cancel printing, press the y Stop button.

Adjusting the Printing Position

If your photo is not centered on the CD or DVD, you may need to adjust the print position. 

1. Press the Setup button. 

2. Select CD/DVD Position Up/Down or CD/DVD Position Left/Right, then press the 
r button.

1-up One photo is printed on the CD/DVD, centered.

4-up
Four photos are printed on the CD/DVD, with one photo in each 
quarter.

8-up 8 photos are printed on the CD/DVD, arranged in a circle.

12-up 12 photos are printed on the CD/DVD, arranged in a circle.
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3. If you are adjusting up and down, press d to move the image down, or u to move it up. 
Then press the OK button. You can adjust the position by up to 2 mm in either direction. 

If you are adjusting left and right, press l to move the image left, or r to move it right. 
Then press the OK button. You can adjust the position by up to 2 mm in either direction. 

4. Press the OK button to set the changes you made and return to the Setup menu. 

Note: The printer remembers this setting even after it has been turned off, so you don’t 
need to adjust the position each time you use the CD/DVD function. 

Resetting Default Settings

You can reset the printer’s settings (such as the layout, color effects, or crop settings) to the 
default settings before printing other photos. 

1. Press the Setup button. 

2. Press u to choose Restore Factory Settings. 

3. Press r. 

4. Press OK. 

5. Press the Setup button to exit the Setup menu. 

Note: Not all settings are returned to their defaults using the Restore to Factory Settings 
feature.
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Printing From Your Computer

When you print from your computer, you can edit and enhance photos, create custom CDs 
or DVDs with your text or photos, or create greeting cards and calendars. Before you start, 
make sure your printer software is installed as described on the Start Here sheet. 

Follow the instructions in these sections to print your photos:

■ “Basic Printing in Windows” below

■ “Basic Printing in Mac OS X” on page 31

■ “Selecting the Correct Paper Type” on page 34

■ “Printing Borderless Photos” on page 35

■ “Printing on CDs or DVDs” on page 38

Basic Printing in Windows

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo R340 Series is selected.

3. Click the Preferences or Properties button. (If you see a Setup, Printer, or Options 
button, click it. Then click Preferences or Properties on the next screen.)

Select your printer name here

Click here to open 
your printer software
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You see the Printing Preferences or Properties window:

4. Select a Quality Option:

■ Draft: For rough drafts with reduced print quality.

■ Text: For text-only documents with higher text quality.

■ Text & Image: For documents with text and images with higher quality.

■ Photo: For photos and graphics with good quality and speed.

■ Best Photo: For photos or graphics with high print quality.

Note: The Quality Option settings on this screen give you the best combination of quality 
and speed for most prints. For information on selecting the highest quality (Photo RPM®) 
on selected papers, see your on-screen User’s Guide.

You can select page layout settings by clicking the Page Layout tab in the Printing 
Preferences or Properties window.

5. Select the paper Type and Size for the paper you’ve loaded. See “Selecting the Correct 
Paper Type” on page 34 for more information about paper types.

6. Select your document or image Orientation.

Tip: For more information about printer settings, click the ? or Help button.

7. Click OK to close the Printing Preferences or Properties window.

8. At the Print window, click OK or Print to start printing. 

Select the type of document you’re printing

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image orientation
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During printing, this window appears and shows the progress of your print job. You can use 
the buttons to cancel, pause, or resume printing. You can also see how much ink you have left. 

Selecting Default Settings

Your printer settings only apply to the program you’re currently using. If you want, you can 
change the Windows default printer settings for all your programs. 

1. Right-click the  printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown on page 30.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.

Basic Printing in Mac OS X

Follow the steps below to print a document. 

1. From the File menu, select Page Setup. You see a screen like this: 

Click to cancel printing

Click to pause or 
resume printing

Select Stylus Photo R340

Select your Paper Size

Select your document or 
image orientation
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2. Select Stylus Photo R340 in the Format for pop-up menu.

3. Select the Paper Size for the paper you’ve loaded.

Note: To print without borders, see page 35. To print double-sided pages, refer to your 
on-screen User’s Guide (see page 8). 

4. Select your document or image Orientation.

5. Click OK to close the Page Setup window.

6. From the File menu, select Print. You see a screen like this: 

7. Open the Printer menu and select Stylus Photo R340. 

8. Select Print Settings from the pop-up menu.

9. Select the following Print Settings as necessary:

Note: The Quality setting on this screen gives you the best combination of quality and 
speed for most prints.

Select Stylus Photo R340

Select Print Settings

Select Quality or Speed 
(for faster printing)

Select your media type 
(see page 34)

Select Automatic mode 

Select Color (for color 
documents and black and 
white photographs) or 
Black for black text 
documents
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Tip: For more information about printer settings, click ?.

10. You can also choose these options from the Print Settings pop-up menu:

■ Copies & Pages: For selecting the number of copies or a page range.

■ Layout: For selecting page layout options. 

■ Color Management: For adjusting the color controls, changing the gamma setting, 
or turning off color adjustments by the printer software. 

■ Summary: For viewing a list of all your selections.

11. Click Print.

12. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock. Then double-click your printer name (Stylus Photo R340). 

In Mac OS X 10.3.x or 10.4.x, click the  Stylus Photo R340 icon when it appears in 
the dock.

You see a screen that shows the progress of your print job:

13. You can do one of the following: 

■ Click the print job, then click Delete to delete the job. 

■ Click the print job, then click Hold to pause printing.

■ Click a print job marked “Hold” and click Resume to resume printing.

■ If multiple print jobs are listed and you want one to print before the other(s), select 
the job and click the Status arrow to move it up.

14. When you’re finished, close your printer window or Print Center. 
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Selecting the Correct Paper Type 

When printing, always be sure to select the correct paper Type (Windows) or Media Type 
(Macintosh) setting. This tells the printer what kind of paper you’re using so it can adjust the 
ink coverage accordingly. 

Here are the settings you should choose for your paper when printing from your computer:

Note: The availability of paper types varies by location. 

For this paper

Select this Paper Type/Media 

Type setting

Plain paper sheets 

Epson Iron-On Transfer Paper

Plain Paper

Epson Premium Bright White Paper Bright White Ink Jet Paper

Epson Photo Quality Ink Jet Paper

Epson Photo Quality Ink Jet Cards

Epson Photo Quality Self Adhesive Sheets 

Epson Ink Jet Transparencies 

Photo Quality Ink Jet Paper

Epson Matte Paper Heavyweight

Epson Double-Sided Matte Paper

PremierArt Matte Scrapbook Photo Paper for Epson

Matte Paper - Heavyweight

Epson Photo Paper Photo Paper

Epson Glossy Photo Paper

Epson Photo Quality Glossy Paper

Epson Glossy Photo Greeting Cards

Glossy Photo Paper

Epson Ultra Premium Glossy Photo Paper Ultra Premium Glossy Photo Paper

Epson Premium Glossy Photo Paper Premium Glossy Photo Paper

Epson Photo Stickers® Photo Stickers

Epson Premium Luster Photo Paper

Epson ColorLife Photo Paper

Premium Luster Photo Paper

Epson Premium Semigloss Photo Paper

Epson Semigloss Scrapbook Photo Paper

Premium Semigloss Photo Paper

Envelopes Envelopes
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Printing Borderless Photos

You can print your photos without margins, extending the image all the way to the edges of 
the page. Although borderless printing is a bit slower, you get beautiful snapshots or 
enlargements without trimming, on these papers and sizes. 

Caution: If you use an unsupported paper size, ink may spray inside your printer and mar future 
printouts.

See these sections for instructions on selecting printer settings:

■ “Windows” on page 36

■ “Mac OS X” on page 37

Paper name Sizes

Paper Type (Windows) or

Media Type setting (Macintosh)

Epson Matte Paper 
Heavyweight

Letter (8.5 × 11 inches)
8 × 10 inches

Matte Paper - Heavyweight

Epson Photo Paper Letter (8.5 × 11 inches) Photo Paper

Epson Glossy Photo 
Paper

Letter (8.5 × 11 inches)
4 × 6 inches

Glossy Photo Paper

Epson Ultra Premium 
Glossy Photo Paper

Letter (8.5 × 11 inches)
4 × 6 inches

Ultra Premium Glossy Photo Paper

Epson Premium Glossy 
Photo Paper

Letter (8.5 × 11 inches)
4 × 6, 5 × 7, or 8 × 10 
inches

Premium Glossy Photo Paper

Epson Premium 
Semigloss Photo Paper

Letter (8.5 × 11 inches)
4 × 6 inches

Premium Semigloss Photo Paper

Epson Premium Luster 
Photo Paper

Letter (8.5 × 11 inches) Premium Luster Photo Paper
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Windows 

1. Start your photo program and open your photo.

2. Open the File menu and click Print. Then click Preferences or Properties. You see a 
screen like this:

3. Select Photo or Best Photo as the Quality Option setting.

4. Choose Sheet as the paper Source setting.

5. Select one of the following paper types:

■ Matte Paper Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Ultra Premium Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

6. Click the Borderless checkbox. Read the message and click OK.

7. Select the paper Size for the paper you’ve loaded.

8. Select your document or image Orientation.

9. Click OK to close the Printing Preferences or Properties window.

10. Click OK or Print to start printing.

Select Photo or 
Best Photo

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image 
orientation

Click the Borderless 
checkbox

Select Sheet
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Mac OS X

1. From the File menu, select Page Setup. You see a screen like this: 

2. Select Stylus Photo R340 in the Format for pop-up menu.

3. Choose the borderless Paper Size for the paper you’ve loaded. 

4. Click OK to close the Page Setup window.

5. From the File menu, select Print.

6. Select Stylus Photo R340 in the Format for menu.

7. Choose Print Settings from the pop-up menu. 

8. Select one of the following media types: 

■ Matte Paper Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Ultra Premium Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

9. Select other print settings as necessary, then click Print to start printing. 

Select Stylus Photo R340 

Choose a borderless 
Paper Size
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Printing on CDs or DVDs

Your printer includes a special tray that lets you print customized text, graphics, and photos 
directly on any ink jet-printable CD or DVD. The EPSON Print CD software makes it easy 
to import your own photos, add text, and modify your designs with a variety of special effects. 
You can print on both standard-size 12-cm CDs and 8-cm mini CDs.

Caution: Use only ink jet-printable CDs or DVDs for printing. Thermal-printable and regular CDs 
and DVDs should not be used with this printer.

Follow the steps in the sections below to print on CDs and DVDs. For information on 
designing CDs and DVDs, see the on-screen help in EPSON Print CD.

■ “Cleaning the Roller” below

■ “Inserting a CD or DVD” on page 39 

■ “Printing Your Design” on page 41

■ “Adjusting the Print Position” on page 41

■ “Adjusting the Print Density” on page 43

Cleaning the Roller

Before you print on CDs or DVDs, it’s a good idea to clean the roller inside the printer. You 
can do this by feeding and ejecting several sheets of plain paper. 

1. Make sure the printer is turned on and letter-size plain paper is loaded in the sheet feeder.

2. Press the Setup button.

3. Press d to select Paper Feed/Paper Eject and press OK. 

4. Press OK to feed paper into the printer. 

5. Make sure Paper Feed/Paper Eject is still highlighted, then press OK. 

6. Press OK again to eject the paper from the printer. 

7. Repeat steps 3 through 6 three or four times.
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Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink jet-printable CDs or DVDs before 
you print. Otherwise, dirt or scratches on the surface may cause errors when you burn the 
data. If you plan to print large numbers of CDs or DVDs, it’s a good idea to print a small 
sample, then wait a day and check the quality to make sure it is satisfactory. 

If you want to check the print position or color, see the instructions for “Adjusting the Print 
Position” on page 41 and “Adjusting the Print Density” on page 43.

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the disc may 
not be positioned correctly. 

Follow these steps to load CDs and DVDs into your printer:

Caution: If you don’t insert the tray correctly, you may damage the printer or tray.

1. Push in the output tray extension and lower the CD/DVD tray guide. 

Lower CD/DVD 
tray guide

Push in 
extension 
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2. Place the CD or DVD on the CD tray with the white or printable side face-up. Make sure 
the disc lies flat on the tray.

To print on a small CD (8-cm), place the small CD ring on the tray first, then place the 
CD inside the ring. 

Caution: Make sure you always use the small CD ring when printing 8-cm CDs and that the CD 
and ring lie flat on the tray; otherwise the printer may be damaged. 

3. Insert the tray into the printer carefully, making sure it is level, not tilted up or down. 

Slide the tray under the tab and the two rollers. Push it in until the arrows on the tray and 
guide are aligned. Don’t push the tray in too far; line up the arrows exactly. 

4. Follow the instructions in “Printing Your Design” on page 41 to print your CD or DVD. 

Always use this ring 
with 8-cm CDs

Line up arrows

Keep tray level

Load tray under tab

Pbasics.book  Page 40  Monday, August 1, 2005  12:31 PM



Printing on CDs or DVDs 41

Printing Your Design

After you have created your design and loaded a CD or DVD, you’re ready to print.

Note: For information on designing CDs and DVDs, see the EPSON Print CD on-screen Help.

1. Open the File menu and select Print.

2. Make sure Stylus Photo R340 is selected, then click Print.

Note: After you print, handle the CD or DVD carefully. To allow the ink to dry fully, wait at least 
24 hours before playing the disc or inserting it in a drive. Keep printed discs away from 
moisture and direct sunlight.

If you want to check the print position or color, see the instructions for “Adjusting the Print 
Position” below and “Adjusting the Print Density” on page 43.

Adjusting the Print Position

If your printed images and text are not centered the way you want, you may need to adjust 
the printing position. Use the blank cardboard position check disk included with your printer 
or an extra CD. You can also use these steps to check the position before you print on a CD 
or DVD. 

1. Place the position check disk (or an extra CD) on the CD tray and insert it into the 
printer, as described on page 39.

2. Start EPSON Print CD.

3. Select Print from the File menu.

Macintosh

Windows
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4. Make sure Stylus Photo R340 is selected, then click Print Position Confirmation 
Pattern (Windows) or Print Position Check Pattern (Macintosh).

5. Click Print. The confirmation pattern is printed on the position check disk or CD.

6. Remove the position check disk or CD and measure the distance from the edge of the 
hole to the small cross marks (distances labeled A and B as shown). You’ll need a metric 
ruler with millimeters for these measurements.

Macintosh

Windows
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7. Open the File menu and select Print, then click the Position Adjustment or Adjust 
Print Position button. You see a screen like this:

8. Make sure Enter Values (Windows) or Value Entry (Macintosh) is checked. Input the A 
distance in the Height (Top) or Top Space box. Enter the B distance in the Width 
(Right) or Right Space box.

9. Click OK to save the measurements.

Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color saturation or 
ink density. Discs from different manufacturers may absorb ink differently, so you may need 
to adjust the density for each type of disc. Follow these instructions to print a color saturation 
check pattern and make adjustments as necessary.

1. Insert a test CD or DVD for printing, as described on page 39.

2. Start EPSON Print CD.

3. Select Print from the File menu.

4. Make sure Stylus Photo R340 is selected, then click Print Density Confirmation 
Pattern (Windows) or Print Density Check Pattern (Macintosh).

5. Click Print.

6. After the pattern is printed, examine the print and make the Print Color Correction 
(Windows) or Color Correction (Macintosh) setting lighter or darker as necessary.

Enter measurements here

MacintoshWindows

Enter measurements here
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7. After the first pattern is printed, adjust the setting, then repeat steps 3 through 6, 
selecting Second or Second Time to print the second pattern. 

Note: You can print three density patterns on one disc. Each pattern is printed in a 
different location.

8. If you want to try a third Color Correction setting, you can repeat steps 3 through 6 again 
and select Third or Third Time.

9. Remove the CD or DVD and let it dry for at least 24 hours. Then check the saturation 
levels again.

You can also use the Brightness and Contrast settings in EPSON Print CD to adjust color 
saturation. See the EPSON Print CD on-screen help for instructions. 
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Maintaining Your Printer

This chapter describes maintenance procedures to keep your printer working its best and 
preparation steps for moving your printer. Follow the instructions here for: 

■ “Cleaning the Print Head” below

■ “Replacing an Ink Cartridge” on page 47

■ “Aligning the Print Head” on page 50

■ “Cleaning the Printer” on page 50

■ “Transporting the Printer” on page 51

■ “Adjusting the LCD Brightness” on page 52

Note: You can also maintain your printer from the Maintenance tab on your driver (Windows) 
or from the Epson Printer Utility (Macintosh). For details, read your on-screen User’s Guide 
(described on page 8).

Cleaning the Print Head

If your printouts are unexpectedly light or faint, or dots or lines are missing from the image, 
you may need to clean the print head. This unclogs the nozzles so they can deliver ink 
properly. Print head cleaning uses ink, so clean it only if quality declines.

You can clean the print head either from the printer’s control panel or using your printer 
software. To clean it using the printer software, the printer must be connected directly to your 
computer (not over a network); see your on-screen User’s Guide for details.

Caution: When you don’t turn on your printer for a long time, the print quality can decline, so 
turn it on at least once a month to maintain good print quality.

Follow these steps to clean the print head from the printer’s control panel:

1. Make sure the printer is turned on but not printing.

2. Press the Setup button.

3. Press d to highlight Head Cleaning, then press OK.
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4. To begin cleaning, press Print. The printer makes noise and you see a progress bar on the 
LCD screen. Cleaning takes about 30 seconds.

Caution: Do not turn off the printer or interrupt the cleaning process.

5. When cleaning is done, press OK to run a nozzle check to confirm the print head nozzles 
are clean.

Make sure letter-size plain paper is loaded in the printer, then press Print. The nozzle 
check pattern prints. 

6. Examine the nozzle check pattern you printed. Each staggered horizontal and straight 
vertical line should be complete, with no gaps in the pattern, as shown below:

■ If your printout looks okay, you’re done. Press Back to finish.

■ If there are any gaps (as shown below), press OK and then Print to clean the print 
head again. 

If you don’t see any improvement after cleaning three or four times, check the solutions 
beginning on page 57. You can also turn the printer off and wait overnight—this allows 
any dried ink to soften—and then try cleaning the print head again. 
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Replacing an Ink Cartridge

You can check the status of the ink cartridges by looking at the icons on the control panel. 

1. Press Setup.

2. Press d to choose Ink Levels, then press OK. 

The level of ink shown on the icons indicates the 
approximate amount of ink remaining. If an ink cartridge is 
low, you see a caution symbol. This is a good time to make 
sure you have a replacement cartridge. 

If an ink cartridge is empty, you see a message on the display 
telling you that the cartridge needs to be replaced.

3. Press OK, then press Setup to exit the Setup menu. 

Caution: You cannot print if any ink cartridge is empty. Leave the empty cartridge installed in 
the printer until you have obtained a replacement, or the ink remaining in the print head nozzles 
may dry out. To ensure good results, use genuine Epson ink cartridges and do not refill them. 
Other products may cause damage to your printer not covered by Epson’s warranty.

When an installed cartridge is more than six months old, you may need to replace it 
if printouts don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge. 

Use these Epson ink cartridges within six months of installing them and before the expiration 
date on the package:

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the 
nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit 
www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for reseller 
referral.

Cartridge Part number

Black T048120

Cyan T048220

Magenta T048320

Yellow T048420

Light Cyan T048520

Light Magenta T048620
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start the ink cartridge 
replacement procedure, you must complete all the steps in one session. 

1. Make sure the printer is turned on and not printing, then open the printer cover.

2. If you see an Ink Out message, press OK. If you don’t see a message, press the Setup 
button, then Press d to choose Ink Cartridge Replacement, then press OK. Press OK 
again. The print head moves to the replacement position.

3. Open the cartridge cover. 

4. Press in the tab on the back of the cartridge and lift the cartridge out of the printer. 
Dispose of it carefully.

Warning: Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your 
eyes, flush them thoroughly with water.
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5. Unwrap the new ink cartridge.

Caution: Don’t touch the green circuit board or remove any labels. 

6. Lower the cartridge into the holder, with the green circuit board 
facing the front. Then gently push the cartridge down until it 
clicks into place. 

7. If you need to replace another ink cartridge, repeat steps 4 through 6 before continuing 
with step 8.

8. Close the ink cartridge cover.

9. Press OK and close the printer cover. 

The printer begins charging the ink delivery system. 

10. When you see a message that charging is complete (after about a minute), press OK.
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Aligning the Print Head

If your printouts contain misaligned vertical lines or horizontal banding, you may need to 
align the print head. 

You can align the print head either from the printer’s control panel or using your printer 
software. To align the print head from the printer software, the printer must be connected 
directly to your computer (not over a network); see your on-screen User’s Guide for details.

Note: For the best results, load letter-size Epson Photo Quality Ink Jet Paper in the printer 
whenever you check the print head alignment.

Follow these steps to align the print head using the control panel:

1. Make sure the printer is turned on but not printing, and 
letter-size paper is loaded.

2. Press the Setup button.

3. Press d to choose Head Alignment, then press OK.

4. Press the x Start button to print the alignment pattern. 

5. Once the pattern is done printing, examine the first row or 
set of boxes (marked #1). Select the box (1-9) which is most 
evenly printed, with no noticeable streaks or lines. You may 
need to use a magnifying glass.

6. Press r, press u or d to choose the box number, then press 
OK. 

7. Repeat step 6 to select the best box for sets #2, #3, and #4.

8. When you’re finished, press OK. 

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. Follow
these steps: 

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.

2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet feeder.

3. Clean the exterior of the printer with a soft, damp cloth. 
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4. Use a soft, dry cloth to clean the LCD screen and preview monitor. Do not use liquid or 
chemical cleaners on these parts.

5. If ink has spilled inside the printer, wipe it off only in the area shown below using a soft, 
damp cloth.

Caution: Be careful not to wipe away lubricating grease inside the printer. 

Don’t touch the gears inside the printer.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can damage the 
printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils inside the 
printer.

Don’t use any cleaning sheets included with special paper; they may jam inside the printer.

Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in its 
original box or one of a similar size. 

Caution: To avoid damage, always leave the ink cartridges installed when transporting the 
printer.

1. Turn on the printer, wait until the print head locks in the far right position, then turn off 
the printer.

2. Unplug the power cord from the electrical outlet. 

3. Remove any memory cards from the printer and close the memory card cover. 

4. Remove any paper from the printer, push down the paper support extension, and close 
the paper support.

Clean here
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5. Open the printer cover. Secure the ink cartridge holder to the printer with tape as shown, 
then close the printer cover. 

6. Make sure the CD/DVD tray guide is closed, then push in the output tray extension and 
close the output tray. 

7. Repack the printer and its attachments in the original box using the protective materials 
that came with them. See your Start Here sheet.

Keep the printer level as you transport it. After transporting the printer, remove the tape 
securing the print head and test your printer. If you notice a decline in print quality, clean the 
print head (see page 45); if output is misaligned, align the print head (see page 50). 

Adjusting the LCD Brightness

You can adjust the LCD brightness for the best view depending on the lighting conditions in 
the room where your printer is located. 

1. Press the Setup button. 

2. Press d to highlight Photo Viewer Adjustment and press OK. 

3. Press the u and d buttons to adjust the display, using the sample image as a guide. 

4. Press OK. 

Tape the ink cartridge 
holder to the printer case
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Problem Solving

See these sections to diagnose and solve printer problems: 

■ “Diagnosing Problems” below

■ “Setup or Software Installation Problems” on page 56

■ “Printer Problems” on page 57

■ “Print Quality Problems” on page 59

■ “Problems With Paper Feeding” on page 61

■ “CD/DVD Printing Problems” on page 62

■ “Miscellaneous Printout Problems” on page 62

■ “Uninstalling Printer Software” on page 64

■ “Where To Get Help” on page 65

Diagnosing Problems 

Your Epson Stylus Photo R340 includes a number of ways to help you diagnose problems: 

■ To identify the most common problems, check for messages on the control panel display 
and follow the instructions provided. Some of the most common messages are explained 
in the next section. 

■ If you’re not sure whether the problem is coming from your printer or the computer, run 
a printer check as described on page 55. 

■ Check the solutions in other sections in this chapter. If none of the suggested solutions 
solve your problem, contact Epson as described on page 65. 

Pbasics.book  Page 53  Monday, August 1, 2005  12:31 PM



54 Problem Solving

Control Panel Messages 

Message Solution

Ink out.
Black: T048120
Cyan: T048220
Magenta: T048320
Yellow: T048420
Light Cyan: T048520
Light Magenta: T048620

The genuine Epson ink cartridges listed above 
are recommended for replacement.

Replace the ink cartridges shown with 
new ones.

Paper or CD/DVD tray jam or feed error. Press 
the Start button. If the error does not clear, 
reinsert the paper or CD/DVD tray and Press 
the Start button. 

Reload paper in the sheet feeder (see 
page 9) or remove and reinsert the 
CD/DVD tray (see page 39) and press 
the x Start button. The printer resumes 
printing.

Paper out. Load paper and press the Start 
button. 

Load paper in the sheet feeder (see 
page 9) and press the x Start button. 
The printer resumes printing.

Ink cartridges cannot be recognized.
Black: T048120
Cyan: T048220
Magenta: T048320
Yellow: T048420
Light Cyan: T048520
Light Magenta: T048620

The genuine Epson ink cartridges listed above 
are recommended for replacement.

Reinstall the cartridge shown (see 
page 47). 

Service required.

Parts inside your printer are at the end of their 
service life. See your printer’s documentation 
for details.

Contact Epson (see page 65).

Printer error occurred. Please see your manual. Turn the printer off and then back on. If 
the error message still appears, contact 
Epson (see page 65).

No memory card or disk inserted, or it cannot 
be recognized.

Use a compatible, formatted memory 
card (see page 11). 
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Running a Printer Check

You may need to run a printer check to see if a problem comes from the printer itself or some 
other source. 

1. Make sure any memory cards are removed (page 16), then disconnect the printer cable 
from the printer. 

2. Make sure that letter size paper is loaded in the sheet feeder, the CD/DVD tray is not 
inserted in the printer, and the CD/DVD guide is up.

3. Press the Setup button.

4. Press d to choose Nozzle Check. Press the r button, then press OK. The printer prints 
the nozzle check pattern.

Make sure the memory card or storage disk has 
been inserted correctly. If so, check to see if 
there is a problem with the card or disk and try 
again.

Use a compatible, formatted memory 
card (see page 11) or a compatible 
storage device (see page 12). 

Cannot recognize the device. Make sure the memory card has been 
inserted correctly (see page 11). If you 
connected a USB device, make sure the 
disk has been inserted correctly (see 
page 12).

Cannot perform the print head cleaning due to 
low ink level.

You need enough ink to perform print 
head cleaning. Replace the ink cartridge 
that is low. 

Message Solution
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5. Compare the quality of the printed check page with the sample shown below. If there are 
no print quality problems, such as gaps or missing segments in the test lines, the printer 
itself is fine. The problem probably lies with the printer driver settings, the application 
settings, the interface cable (be sure to use a shielded cable), or the computer itself.

If the check page does not print satisfactorily, as shown below, or if it doesn’t print at all, 
there is a problem with the printer. For example, if any segment of the printed lines is 
missing, this could mean a clogged ink nozzle. 

Setup or Software Installation Problems

The printer makes noise after ink cartridge installation.

■ The first time you install ink cartridges, the printer must charge its print head for about 
two minutes. Wait until charging finishes before you turn off the printer, or it may charge 
improperly and use excess ink the next time you turn it on. 

■ Make sure the ink cartridge cover is closed completely and no packing material remains in 
the printer. Turn off the printer, wait a moment, then turn it back on to clear the error.

You’re having problems installing the printer software.

■ Carefully follow the installation instructions on the Start Here sheet. Do not connect your 
printer to the computer until you are instructed to connect it. Connect the printer cable 
securely to the printer and the computer. Also make sure your system meets the 
requirements on page 67.

■ Close your other programs, including any screen savers and virus protection software, and 
install again.

■ If you are using Mac OS X and you do not see the printer name in the Format for menu 
under Page Setup, you may need to set up your printer in the Print Center or Printer 
Setup Utility. See the Start Here sheet for instructions. 
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■ With Windows 2000, if you see an error message or your software doesn’t install correctly, 
you may not have software installation privileges. Contact your System Administrator.

■ Make sure Windows 98SE, Me, 2000, or XP was preinstalled on your system. The USB 
Printer Device Driver may not install correctly if you’ve upgraded from Windows 95.

■ Make sure the USB Controller is working properly in Device Manager. See your 
Windows help system for details. If it’s not working, contact your computer 
manufacturer.

■ If you’re printing over a network, see your on-screen User’s Guide for instructions on 
configuring your printer for use on a network. 

Printer Problems

The printer is on, but nothing prints.

■ If you’re printing from your computer, make sure the USB cable is connected securely and 
that the cable meets the system requirements on page 67.

■ If you’re printing from your computer, run a printer check as described on page 55. If the 
check page prints, make sure your software is installed correctly. 

■ If you’re printing on a network, you need to set up your printer for network printing, as 
described in your on-screen User’s Guide.

The printer sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. To clean the print head, see page 45.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable 
surface that extends beyond the printer base in all directions.

Your printer makes noise when you turn it on or after it has been sitting for awhile. 

Your printer is performing routine maintenance. 

The LCD panel and control panel respond too slowly. 

When you have multiple photos or large files on your memory card, it takes longer for the 
LCD panel to process them. This causes the LCD and control panel to respond more slowly. 
Try deleting any photos you don’t need before you remove the card from your camera.
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Printing is too slow. 

Make sure your system meets the requirements listed on page 67. If you’re printing a 
high-resolution image, you need more than the minimum requirements listed. You may also 
need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close open programs that you’re not using.

■ Increase your system’s memory (RAM).

For the fastest printing, try these tips:

■ Choose Black ink if your document doesn’t include color (except for black-and-white 
photos).

■ Set the Quality/Speed slider to Speed.

■ In the Advanced options, turn MicroWeave® off and/or turn High Speed on. 

■ If your printer is connected to a hub, disconnect USB devices that you’re not using.

Note: Borderless printing takes longer than normal, especially near the edges of the paper. 
Printing without a computer is also a bit slower.

■ If you are printing a landscape photo without a computer, it takes longer for the printer to 
rotate and process the image.

Your memory card does not work correctly. 

■ If you’re using different kinds of memory cards, make sure only one card is inserted at a 
time.

■ Make sure the card contains no more than 999 photos (or the last photos won’t display), 
and that the photos are in JPEG or Uncompressed Tiff format and taken with a 
DCF-compliant digital camera.

■ If you access the card from your computer and delete files, the card may not work 
correctly with your camera. Always delete pictures using your camera.

■ If you’re using Windows XP, you may need to install your Windows storage device driver. 
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Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need cleaning; see page 45 for instructions. 

■ Select a higher print quality and turn off High Speed mode. See page 29 (Windows) or 
page 31 (Macintosh).

■ If you’re printing without a computer, make sure the printer’s Paper Type setting matches 
the type of paper you’re using; see page 20 for guidelines.

■ If you’re printing from a computer, make sure the paper Type or Media Type setting 
matches the paper you loaded; see page 34 for guidelines.

■ Make sure you load paper with the printable side face up. The printable side is usually the 
whiter or brighter side of the paper. 

■ The ink cartridges may need replacing. To replace an ink cartridge, see page 47.

■ Run the Print Head Alignment utility; see page 50 for instructions. 

Your printout is blurry or smeared. 

■ Use Epson papers to ensure proper saturation and absorption of genuine Epson inks. 

■ Make sure you load paper with the printable side face up. The printable side is usually the 
whiter or brighter side of the paper. 

■ Make sure your paper isn’t damp or curled, or loaded face down (the printable side should 
be face up). If it’s damp or curled, reload a new stack of paper.

■ When printing on special paper, check the instructions in the paper package. You may 
need to use an included support sheet or load your paper one sheet at a time.

■ Make sure your paper meets the specifications listed in the on-screen User’s Guide. 

■ Run the Print Head Alignment utility; see page 50 for instructions.

■ Remove each sheet from the output tray after printing, especially when you’re printing on 
transparencies.

■ If the options above don’t work, try using the thick paper and envelopes setting: 

Windows: From the Maintenance tab in the Printing Properties or Preferences window, 
click Printer and Option Information, then select Thick paper and envelopes. 

Mac OS X: From the Print window, choose Extension Settings in the pop-up menu, 
then select Thick paper and envelopes.
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Make sure you disable the thick paper and envelopes option before printing on other 
types of paper, or print quality may be reduced. 

Your printout is grainy. 

■ Try using a higher quality paper.

■ Select a higher print quality setting. If you’re printing from Windows, see page 29. If 
you’re printing from a Macintosh, see page 31. 

■ Run the Print Head Alignment utility; see page 50 for instructions.

■ You may need to increase the image resolution or print it in a smaller size; see your 
software documentation.

Your printout is faint or has gaps in the image. 

■ The print head nozzles may need cleaning; see page 45 for instructions. 

■ The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 47. 

■ If you’re printing without a computer, make sure the printer’s Paper Type setting matches 
the type of paper you’re using; see page 20 for guidelines.

■ If you’re printing from a computer, make sure the paper Type or Media Type setting 
matches the paper you loaded; see page 34 for guidelines.

■ Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, reload a new 
stack of paper with the printable side up; it is usually whiter or shinier.

You see wrong or missing colors.

■ Make sure the Ink setting is set to Color for color images or black-and-white photos. Also 
make sure your software is set for color printing.

■ The print head nozzles may need cleaning; see page 45 for instructions.

■ The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 47.

■ Try turning off PhotoEnhance. Also check if you’re using a special effect that alters image 
colors, like Sepia. 

■ Try changing the Gamma setting in the Advanced window; see your on-screen User’s 
Guide for information about accessing Advanced settings.

■ Your printed colors can never exactly match your on-screen colors. However, you can use 
a color management system to get as close as possible. You can also use your printer’s color 
management features. See your on-screen User’s Guide for more information.
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■ Colors will change slightly after drying. Wait for 24 hours and check your print again to 
see if the colors look right. 

■ If you are printing without a computer, check your printer’s control panel settings to 
make sure the Filter setting is not set to Sepia or B&W and that the image adjustment 
settings are set to Standard (see page 22).

Problems With Paper Feeding

Paper doesn’t eject fully or is wrinkled. 

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
x Start button to eject the paper, then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin.

Paper doesn’t feed correctly or jams in the printer. 

■ Make sure the paper support extension is pulled up. 

■ If paper doesn’t feed, remove it from the sheet feeder, reload it against the right edge, then 
slide the left edge guide against the paper.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to 
separate the sheets, and carefully reload it.

■ If paper jams, press the x Start button to clear the jam. If that doesn’t clear the paper 
jam, open the cover and remove any jammed paper, including small pieces that may have 
torn off. Reload the paper and press the x Start button.

If your paper loads incorrectly or jams frequently:

■ Use new, smooth, high-quality paper, loaded printable side up. Don’t load paper above 
the arrow mark on the left edge guide.

■ Place the paper against the right edge and slide the left edge guide against it, but not
too tightly.

■ Store paper flat to prevent curling. 
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CD/DVD Printing Problems

Images and text are not centered on the CD/DVD. 

Adjust the print position as described on page 41.

Ink smears on the CD/DVD or printing is too light.

■ Adjust the print density as described on page 43. 

■ Adjust the brightness or contrast (see the EPSON Print CD on-screen help for details).

■ Make sure you’re using ink jet-printable CDs or DVDs.

■ Handle the disc carefully and allow the ink to dry for at least 24 hours before playing the 
disc or inserting it in a drive. 

Printed CDs or DVDs are smeared or dirty.

Clean the roller; see page 38.

The CD or DVD won’t feed into the printer.

Make sure you hold the CD/DVD tray level as you load it into the tray guide, not tilting it up 
or down. Don’t push in the tray too far, but line up the arrows exactly as described on page 40. 

Miscellaneous Printout Problems

The image is reversed.

Turn off the Flip Horizontal setting in the Page Layout screen (Windows), Print Settings 
window under the Advanced settings (Macintosh), or the mirror setting in your program. (If 
you’re printing on Epson Iron-On Transfer Paper, the image should be reversed.)

The printer prints blank pages.

■ Make sure your printer is selected, or is the active printer in the Print Center or Printer 
Setup Utility.

■ The print head nozzles may need cleaning; see page 45 for instructions. 
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The margins are incorrect. 

■ Make sure the paper settings are correct for your paper size. 

■ Make sure the paper is positioned correctly in the feeder, all the way to the right. Slide the 
left edge guide against the paper. 

■ See your software documentation for instructions on choosing the correct margins for 
your paper size. The margins must be within the printable area of the page. See “Printer 
Specifications” in your on-screen User’s Guide.

■ If you are printing without a computer, make sure the Crop and Fit to Frame settings are 
set to Off; see page 23 for instructions. 

Image size or position is incorrect.

■ Make sure paper and layout options are set correctly.

■ Your images may not match the width/height proportions (aspect ratio) of the paper size 
or layout you’re using. Images may be cropped to fit the paper and layout.

You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the system requirements on 
page 67. Then try printing again.

■ Make sure your printer is selected in your software, or is set as an active printer in the 
Print Center or Printer Setup Utility. 

■ If you’re using a USB hub, connect the printer directly to your computer instead.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for multiple 
copies. 
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Uninstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities. For example, 
this might be necessary when you upgrade your operating system. 

Note: Remember that you don’t need to uninstall and reinstall your optional photo software or 
on-screen User’s Guide, and you won’t see the license agreement.

Windows

1. Make sure the printer is on and connected your computer. 

2. Click Start > Settings > Control Panel (Windows XP: click Start > Control Panel). 

3. Double-click Add/Remove Programs. 

4. Click EPSON Printer Software in the program list and click the Add/Remove button 
(Change/Remove in Windows 2000 and XP).

5. In the next window, make sure your EPSON Stylus Photo R340 icon is selected and 
click OK. Then follow the on-screen instructions. 

6. In Windows 98SE or Me, click EPSON USB Printer Devices in the program list and 
click the Add/Remove button. When you see the prompt asking if you want to reboot, 
click No. 

7. Restart your computer when you’re done. 

When you are ready to reinstall the printer software, follow the instructions for your operating 
system on the Start Here sheet. 

Mac OS X

1. Open your Applications folder. 

2. Open the Utilities folder (in the Applications folder). 

3. Double-click the Print Center or Printer Setup Utility icon.

4. Select Stylus Photo R340, then click Delete. 

5. Close Print Center or the Printer Setup Utility. 

When you are ready to reinstall the printer software, follow the correct instructions for your 
operating system on the Start Here sheet. 
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Where To Get Help 

Epson provides technical assistance 24 hours a day through the electronic support services and 
automated telephone services listed below:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7296, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 
4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Before you call, please have the following information ready:

■ Product name (Epson Stylus Photo R340)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration

■ Description of the problem

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the 
nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit 
www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for reseller 
referral. 

Service Access

World Wide Web From the Internet, you can reach Epson Support at 
http://support.epson.com. At this site, you can download drivers 
and other files, look at product documentation, access 
troubleshooting information, and receive technical advice through 
e-mail.

Automated 
Telephone Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your Epson 
SoundAdviceSM Express code is 82720. Use this code to quickly 
select the Epson Stylus Photo R340 in SoundAdvice.

Pbasics.book  Page 65  Monday, August 1, 2005  12:31 PM



66 Problem Solving

Pbasics.book  Page 66  Monday, August 1, 2005  12:31 PM



67

Notices

Windows System Requirements 

■ A Microsoft Windows compatible PC with a Pentium® or better processor, 300 MHz or faster

■ Windows 98SE, Windows Me, Windows 2000, or Windows XP

■ 256MB of RAM (512MB or more recommended)

■ 200MB or more available hard disk space recommended

■ VGA or better display adapter and monitor

■ CD-ROM or DVD drive for installing the printer software

■ Windows-compliant USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

Caution: Using an improperly shielded USB cable—especially a cable more than 6.5 feet 
(2 meters) long—may cause the printer to malfunction.

Macintosh System Requirements 

■ An Apple® iMac™ series, Power Macintosh® G3, G4, or G5, PowerBook,® iBook,™ or eMac™

■ Mac® OS X 10.2.4 or later

■ 512MB of available RAM 

■ 200MB or more available hard disk space recommended

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software

■ Built-in USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

Caution: Using an improperly shielded USB cable—especially a cable more than 6.5 feet 
(2 meters) long—may cause the printer to malfunction.
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Important Safety Instructions 

Before using your printer, read the following safety instructions to make sure you use the printer safely 
and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere 
rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

■ When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down. 
Otherwise, ink may leak from the cartridges.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

■ Use a soft, dry cloth only to clean the display and preview monitor. Do not use liquid or chemical 
cleaners on these parts. 

■ Always turn the printer off using the P Power button. It may take a moment for the printer to 
shut off after you press the button. Don’t switch off the power strip or unplug the printer until the 
printer is off.

■ Do not block or cover the openings in the printer’s case or insert objects through the slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer yourself. 

■ Do not remove a memory card or turn off the printer while the computer and card are 
communicating (when the light next to the card is flashing). Doing so can corrupt files on the 
memory card. Use only memory cards that are compatible with your printer. 
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■ If the liquid crystal solution from the display or the preview monitor gets on your hands, wash 
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them 
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a 
physician immediately. 

■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the display or preview monitor are damaged; if the printer does 
not operate normally or exhibits a distinct change in performance. Adjust only those controls that 
are covered by the operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and do not drink the ink. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a 
doctor immediately.

■ Do not put your hand inside the printer or touch the cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the package. For best results, use up the 
ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

■ Do not shake an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains 
in the proper position. 
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ENERGY STAR Compliance

As an ENERGY STAR
® Partner, Epson has determined that this product 

meets the ENERGY STAR guidelines for energy efficiency. The EPA 
ENERGY STAR office equipment program is a voluntary partnership 
with the computer and office equipment industry to promote the 
introduction of energy-efficient personal computers, monitors, 
printers, fax machines, and copiers in an effort to reduce air pollution 
caused by power generation.

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson

Type of Product: Ink Jet Printer

Model: B361A

Pbasics.book  Page 71  Monday, August 1, 2005  12:31 PM



72 Notices

Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser that the 
Epson printer covered by this limited warranty statement, if purchased and operated only in the United 
States or Canada, conforms to the manufacturer’s specifications and will be free from defects in 
workmanship and materials for a period of one (1) year from the date of original purchase. For 
warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the 
warranty period, please call the Epson ConnectionSM at (562) 276-7296 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An Epson service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will 
direct you to send your printer to Epson or its authorized service center, where the printer will be fixed 
and sent back to you. You are responsible for packing the printer and for all costs to and from the 
Epson authorized service center. When warranty service involves the exchange of the printer or a part, 
the item replaced becomes Epson property. The replacement printer or part may be new or refurbished 
to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. 
Epson’s liability for replacement of the covered printer will not exceed the original retail selling price of 
the covered printer. Exchange products and parts assume the remaining warranty period of your 
original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned 
products. This warranty covers only normal use in the United States and Canada. Using this product 
for continuous production or similar high duty purposes is not considered normal use; damage, 
maintenance or service from such use will not be covered under this warranty. This warranty is not 
transferable. This warranty does not cover any color change or fading of prints or reimbursement of 
materials or services required for reprinting. This warranty does not cover damage to the Epson product 
caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not 
cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson 
product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not 
responsible for warranty service should the Epson label or logo or the rating label or serial number be 
removed or should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as 
fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson 
products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be 
identified or reproduced, you will be held responsible for the costs incurred.
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THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY 
ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN 
WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE 
FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR 
INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit http://support.epson.com.

You can also write to:

Epson America, Inc. ■ P.O. Box 93012 ■ Long Beach, CA 90809-3012
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A
Accessories, 65
Adjusting CD/DVD print position, 27 to 28, 

41 to 43
Adjusting display, 52
Adjusting photo quality, 21 to 22
Aligning print head, 50
All photos, printing, 18
Automatic mode, Macintosh, 32

B
Banding, 59
Basic printing

Macintosh, 31 to 33
Windows, 29 to 30

Black & White, 22
Blank pages, 62
Blurry images, 59 to 60
Borderless expansion, 23
Borderless printing, 35 to 37
Brightness, 22

display, 52
Buttons

Memory Card, 17

C
Cable, printer, 67
Camera, 12 to 14
Cancelling printing

Macintosh, 33
Windows, 30
without a computer, 18, 19

Card light, 12
CD-ROM drive, 12 to 14

CDs
adjusting print density, 22, 43 to 44
adjusting print position, 27 to 28, 41 to 43
cleaning roller, 25, 38
inserting in printer, 25 to 26, 39 to 40
ordering, 24
printing on, 24 to 28, 38 to 44
printing without computer, 24 to 28
problems, 62

Characters, incorrect, 63
Checking printer, 55
Cleaning

print head, 45 to 46
printer, 50
roller, 25, 38
sheets, 51

Color Management settings, Macintosh, 33
Color problems, 60
ColorLife Photo Paper, 34
CompactFlash memory card, 11
Contrast, 22

display, 52
Control panel

messages, 54 to 55
safety, 69

Controlling printing
Macintosh, 33
Windows, 30

Copying photos to computer, 15 to 16
Cropping, 23 to 24

D
Date, printing photos by, 19
Declaration of Conformity, 71
Default print settings, Windows, 31
Default printer settings, restoring, 28
Density, 22
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Diagnosing problems, 53 to 56
Digital camera, 12 to 14
Display brightness, 52
Displaying photos, 10
Door, memory card, 11
DVD drive, 12 to 14
DVDs, see CDs

E
Edge-to-edge printing, 35 to 37
Ejecting memory cards, 16
Electronic manual, 8
ENERGY STAR, 70
Enhancing photos, 22
Epson

accessories, 65
help, 65
ink, 47
papers, 10, 20, 34, 35
Print CD, 38 to 44
Store, 47, 65
warranty, 72 to 73

Error messages, 54 to 55
Exif Print, 22
Expansion, borderless, 23
External devices

connecting, 12 to 13
saving photos to, 14

F
Factory settings, restoring, 28
Faint images, 60
FCC, 70
Filter, 22
Fit to Frame, 24
Flip Horizontal setting, 62
Full bleed printing, 35 to 37

G
Glossy papers, 20, 34, 35, 36, 37
Grainy prints, 60

H
Head Cleaning utility, 45 to 46
Help, Epson, 65
High Speed setting, 58

I
Incorrect

characters, 63
colors, 60
margins, 63

Index, 19
Ink cartridge

level of ink in, 31, 47
ordering, 47
replacing, 47 to 49
safety instructions, 48, 69

Ink Jet Transparencies, 34
Ink level, checking

Windows, 31
without computer, 47

Inserting CD/DVD, 25 to 26, 39 to 40
Installation problems, 56 to 57
Inverted image, 62

J
Jams, paper, 61

L
Layout

CD/DVD, 27
Fit to Frame, 24

Layout problems, 63
Layout settings

Macintosh, 33
Windows, 30
without a computer, 20 to 21

LCD panel
brightness, 52
messages, 54 to 55
problems, 57
safety, 69

Light, memory card, 12
Luster Photo Paper, 20, 34, 35
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M
Macintosh

automatic mode, 32
basic printing, 31 to 33
cancelling printing, 33
system requirements, 67
uninstalling software, 64

Maintaining printer, 45 to 51
Manual settings, without computer, 22
Marginless printing, 35 to 37
Margins, incorrect, 63
Media Type setting, Macintosh, 32, 34, 37
Memory card

adapter, 12 to 14
slide show, 15

Memory Card button, 17
Memory cards

backing up, 14
inserting, 11
problems, 58
removing, 12, 16
types, 11

Memory mode, 17
Memory Stick, 11
Microdrive, 11
MicroWeave setting, 58
Mirror images, 62
MMC, 11
Monitoring ink level

Windows, 31
without computer, 47

Moving printer, 51 to 52
MultiMediaCard, 11

N
Network printing, 57
Noise, printer, 57
Nozzle Check, 46, 55

O
Orientation setting

Macintosh, 32
Windows, 30, 36

Output tray, 9 to 10

P
Page Setup, Mac OS X, 31
Paper

Epson, 10, 20, 34, 35
feeding problems, 61
jams, 61
loading, 9 to 10
orientation, 9 to 10, 32

Paper Size setting
Macintosh, 32, 37
Windows, 30, 36

Paper Source setting, Windows, 36
Paper support, 9 to 10
Paper Type setting

control panel, 20
Windows, 30

Photo viewer adjustment, 52
PhotoEnhance, 22
Photographs

accessing, 11 to 16
adjusting quality, 21 to 22
backing up, 14
copying to computer, 15 to 16
cropping, 23 to 24
displaying and storing, 10
printing with computer, 29 to 37
printing without computer, 17 to 28
saving to computer, 15 to 16
saving to external device, 14
sizing, 23 to 24

Photos
printing, 17 to 21
printing all, 18
printing by date, 19
printing range, 18 to 19
proof sheet, 19
viewing and printing, 18

PictBridge, 12 to 14
Preview monitor, 7
Print CD software, EPSON, 38 to 44
Print dialog box, 29, 32
Print head

aligning, 50
cleaning, 45 to 46

Print Head Alignment utility, 50
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Print quality
problems, 59 to 61
settings, 30, 32

Print settings, without computer, 20 to 21, 22
Print window, 29, 32
Printer

cable, 67
check, 55
cleaning, 50
maintaining, 45 to 51
noise, 57
problems, 53 to 63
transporting, 51 to 52

Printer settings, restoring to defaults, 28
Printing

adjusting CD/DVD position, 27 to 28, 
41 to 43

CDs without computer, 24 to 28
photos, 17 to 21
without computer, 17 to 28

Printing photos
all option, 18
by date, 19
proof sheet, 19
range, 18 to 19
view and print option, 18

Printing with a computer
basic, 29 to 33
borderless, 35 to 37
CDs and DVDs, 38 to 44
controlling, 30, 33

Printing without a computer
adjusting photo quality, 21 to 22
CDs and DVDs, 24 to 28
cropping, 23 to 24
print settings, 20 to 21
selecting photos, 18 to 19
touching up photos, 21 to 22

Printing, slow, 58

Problems
CD/DVD, 62
diagnosing, 53 to 56
error messages, 54 to 55
ink, 54 to 55
installing software, 56 to 57
LCD panel, 57
memory card, 58
miscellaneous, 62 to 63
paper feeding, 61
print quality, 59 to 61
printer, 53 to 63
setup, 56 to 57

Proof sheet, 19
Protecting photos, 10

Q
Quality problems, 59 to 61
Quality setting, 22
Quality Type setting, 30
Quality/Speed setting, 32

R
Range of photos, 18 to 19
Resetting default settings, 28
Resolution Performance Management (RPM), 

7, 30
Roller, cleaning, 25, 38

S
Safety instructions, 68 to 69
Saturation, 22
SD card, 11
Secure Digital card, 11
Self adhesive sheets, 34
Sepia, 22
Sequence of photos, printing, 18 to 19
Settings, printing without computer, 20 to 21
Sharpness, 22
Sizing photos, 23 to 24
Slide show, 15
Slow printing, 58
SmartMedia card, 11
Smeared printout, 59 to 60, 62
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Software
EPSON Print CD, 38 to 44
problems, solving, 56 to 57
uninstalling, 64

Storing photos, 10
System requirements, 67

T
Thumb drive, 12 to 14
Thumbnails, 19
Touching up photos, 21 to 22
Transferring photos to computer, 15 to 16
Transparencies, 34
Transporting printer, 51 to 52
Troubleshooting, 53 to 65
Type setting, Windows, 30

U
Uninstalling software, 64
Unplugging memory cards, 16
USB, 57, 64, 67
USB DP, 12 to 14
USB drive, 12 to 14
User’s Guide, 8
Utilities

Head Cleaning, 45 to 46
Nozzle Check, 46
Print Head Alignment, 50

V
View and print, 18
Viewing photos, 18
Viewing slide show, 15

W
Warranty, 72 to 73
Windows

basic printing, 29 to 30
cancelling printing, 30
default print settings, 31
system requirements, 67
uninstalling software, 64

X
xD Picture Card, 11

Z
Zip drive, 12 to 14
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